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1 ABBREVIATIONS

Abbreviation Explanation

API Application Programming Interface
ASIC Application-specific integrated circuit
CD Compact Disc

IDE Integrated Development Environment

2 INTRODUCTION

2.1 Purpose

The purpose of this document is to describe the steps required to configure Keil uVision3 IDE for
developing Z-Wave applications. Furthermore, the document describes how to download the hex file into
target within the Keil uVision3 IDE.

Keil uVision3 projects created for all the embedded sample applications in Developer’s Kit v4.50 and
v5.01.

Notice: It is not possible to simulate any Z-Wave API calls and associated hardware.
2.2 Audience and prerequisites

The audience of this document is Z-Wave partners and Zensys. Assume that the Z-Wave partner already
is familiar with the Z-Wave Developer's Kit.

2.3 Limitations

Developing Z-Wave applications in the Keil uVision3 IDE tested on only Windows XP.

Zensys A/S Abbreviations Page 1 of 35
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3 SETTING UP KEIL uVISIONS3

To configure the Keil uVision3 IDE for development of Z-Wave applications requires a number of steps.
For detailed descriptions of the necessary steps, refer to the following paragraphs.

3.1 Getting started

The first step is to install the Keil uVision3 IDE and the software on the Z-Wave Developer’s Kit CD.
Tests conducted on the following versions:

1. Keil uVision3 IDE v3.51 (Keil Development Release 01.2007)
2. Z-Wave Developer’s Kit v4.0x, v4.1x, v4.2x, v4.5x and v5.0x

Notice that the directory paths etc. in the Developer’s Kits may change slightly from version to version.
Be also aware of that Developer’s Kits use different Keil linkers e.g. v5.0x use the extended linker LX51
provided in PK51. Some versions of Keil uVision3 IDE may not contain the ZW0201and/or ZW0301
single chips in the device database. Refer to Chapter 5 regarding how to create a Z-Wave single chip in
the device database. With respect to Keil Assembler, C compiler, Linker and Librarian version refer to
Chapter 9.

Zensys A/S Setting Up Keil uVision3 Page 2 of 35
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3.2 Creating a new project

This example shows how to create a project for the LED Dimmer application using US frequency
(908,42MHz). To create new projects, select “New...” -> “pVision Project...” in the “Project” menu

[ pVision3

:EEiIe Edit Wiew Project Debug Flash Peripherals Tools SYCS Window Help

e - Nl el b % % % Sl ZE# |« = 1 |5 @ [BF]) o &M =5 (4] [ 2 | ¥

| Project Workspace

i
Ll U

[
sl
ull

o |G@E. | *Fu. |ETe. |

.

:

g TP Build £ Command }, FindinFiles [N | >|_I
\ I [ EEE

Figure 1. Main window of Keil uVision3 IDE with default layout

Select the project directory and name. In this example the project directory is

C:\DevKit_5_01\Product\LED_Dimmer and the project name is MyProject.

Zensys A/S Setting Up Keil uVision3 Page 3 of 35
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Create New Project

D

My Recent
Dacuments

&l

Desktop

3

by Documents

8

Save jn: | =9 LED_Dimmer

~| o« & Er

CONFIDENTIAL

ty Computer
My Metwork.  File name: |M WProject ﬂ | Save |
Places
Save astpe: | Project Files [*.uv2) | Cancel
Figure 2. Create New Project dialog
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3.2.1 Select target device

Now select the target device from the device database. In this case, we select ZW0201 under Zensys.
The KEIL pVision project options with ZDK 5.01 based API libraries using extended linker LX51.

Select Device for, Target ‘Target 1°

CPU

Yendor  Fensyz

Device:  2wi20 @Use Extended Linker [L<51] instead of BLS1
Toolzet:  CH1 [ Usze Extended Assembler [4:51] instead of A1
Data baze D'escription:

+ @ Sentek Semiconductor Co A 8051 -bazed micracontraller with Z-w ave RF tranceiver,
- TDK 10-kit ADC, SP1, UART, P, 32 EBytes Flash ROM,
< e: Tekmos 2. Butes Code FAM, 256 Evtes DATA Memary, 2K Byles XDATA Memary

+ @: Ternic
+ @: Teridian Semiconductor C
+ @: Tezzaron Serniconductor

< @ Tl

+ @: Trizcend

+ @: Yitesze

+ @: Winbond

= @: Zensys
£1 2wz
£1 Zwo201 3
< »

] | Cancel Help |

Figure 3. Select Device dialog and check required option

In case a ZW0102, ZW0201 or ZW0301 single chip is not available in the device list then read Chapters
5-7 for a description on how to create a new device. Alternatively use a newer version of the Keil
uVision3 IDE.

In the next message box, select “No”:
p¥ision3 X

.\:.:?(} Copy Standard 8051 Starkup Code ko Project Folder and Add File ko Project 7

w |

Figure 4. Confirmation dialog for copying the Standard Startup Code

Zensys A/S Setting Up Keil uVision3 Page 5 of 35
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3.2.2 Select project components

From the ‘Project’ menu, “Manage” submenu, select the ‘Component, Environment, Books...” menu
item.

Change the Project Target and the Groups as shown below:

Components, Environment and Books fE
Fraject Companents l Fu:ulu:lers.-"E:-:tensiu:uns] Bu:n:uks]
Broject Targets: 7 | 4 | ¥ | Groups: U ¥ | Files X r ¥
I .n'l'.. ] || E; aurce |:|:||:|Ee
Znfave Lib
M ave lhc
Set az Curment T arget | Add Files |
] 4 | Cancel Help

Figure 5. Components, Environment and Books dialog with required Groups
Change Project target name (double click on it) to “MyProject”.
Add groups:
e Appl Source Code
e Z-Wave Lib
e Z-Wave Inc

In the “Appl Source Code” group (C:\DevKit_5_ 01\Product\LED_Dimmer) add the application source
code files. Also add here the files from “C:\DevKit_5 01\Product\Util_Func” as shown below.

WARNING: Remember only to add the files from Util_Func used by the application to avoid linker
errors.

The order of .c files in “Files:” list — is a order of corresponded .obj files in linker command line.
Therefore, if .hex files from uVision3 should be identical to the hex files from makefiles (if used), the

Zensys A/S Setting Up Keil uVision3 Page 6 of 35
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order of .c files should be the same as order of corresponded .obj files in linker command line from
makefiles (see .map file, which was generated by makefie). Same with .obj and .lib files in “Z-Wave Lib”
group (see below). .c (.obj, .lib, etc.) files from other groups will be ordered as groups in “Groups:” list.

Components, Environment and Books f'5_<|

Fraject Companents l Fu:ulu:lers.-"E:-:tensiu:uns] Bu:n:uks]

Froject Targets: £ X | 4 ¥ | Groups: 7 2 4 | ¥ | [Files: x|+ ¥
' Appl Source Code e
Zawfave Lib LEDdim.h
Shfave Ino LEDidimn.
ane_button.c
ane_buttan.h
glave_learn.c

slave_learn.h
App_RFSetup. a5l

Set az Curment T arget | Add Files |

0k, | Cancel Help

Figure 6. Required files for Application Source Code group

Take App_RFSetup.a51 from C:\DevKit_5_01\Z-Wave\lO_defines\

Zensys A/S Setting Up Keil uVision3 Page 7 of 35
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In the “Z-Wave Lib” group (C:\DevKit_5_01\Z-Wavel\lib\slave_ZW020x) add the Z-Wave slave library for
the ZW0201 single chip. Also, add RF .obj file (ZW_rf_020x_US.obj) for ZW0201 single chip and US
country frequency from directory C:\DevKit_5_01\Z-Wave\rf_freq.

Components, Environment and Books E'
Fraject Companents l Fu:ulu:lers.-"E:-:tensiu:uns] Bu:n:uks]
Froject Targets: 17 X | ¥ | Groups: X ¥ | Eies: X r +
i AEEI Source Code 2w b 020x_ 105 abj
zw_glave _DW020xslib
ZhWfave [ho
Set az Curment T arget | Add Files |
14 Carcel | Help

Figure 7. Required files for Z-Wave Lib group

Omit adding the RF .obj file in case of the Developer’s Kit v5.00 CD or older is used because the
directory “C:\DevKit_xxx\Z-Wave\rf_freq” doesn’t exist.

Zensys A/S Setting Up Keil uVision3 Page 8 of 35
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In the “Z-Wave Inc” group (C:\DevKit_5_01\Z-Wave\include) add all the Z-Wave library headers files.
The “Z-Wave Inc” group is the same, independent of the targeted sample application and Z-Wave single
chip.

Components, Environment and Books [$_<|

Fraject Companents l Fu:ulu:lers.-"E:-:tensiu:uns] Bu:n:uks]

Froject Targets: 03 % | 3| 4 | | Groups: 2| 4| ¥ | Files >+ 4+

Appl Source Code S _uart_apih s
=4 ave Lib 20200k =
2030k

S _adcdriv_apih

£ _appltimer. b

W _baziz_aplh

W _clazzomd.h
Zw_controller_apih

' _controller_bridoge_apih

i _contraller_installer_apik

2w _contraller_stahic_apih

£ _debug_apih —
S _eep_addr.h

£ _mem_api.h

i _nodemask_apih
2 _non_zero.h
ZW_power_apih
2w RF0200 h
2 RFO30h

R |

|1

Set az Curment T arget | Add Files |

0k, Cancel | Help

Figure 8. Required files for Z-Wave Inc group
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CONFIDENTIAL



INS10246-5 Keil uVision3 IDE User Guide

2008-07-25

3.3 Setting the target options

From the “Project” menu, select the ‘Options for target MyProject’.

In the “Target” tab select Large Memory Model and Code Rom Size.

Options for, Target '‘Release!

Device Target | Ouput| Listing| User | C81 | 451 | L81 Lacate | Lx51 Misc| Diebug | Utiites |
Zensys S 0200

stal [MHz): [EEIL [~ Use On-chip ROM [020-07FFF)

temory Model: |Large: wariables in XDATA j
Code Rom Size: |Large: B4k, prograrm j [ Usze On-chip #Rak [0:0-0:7FF)

O perating sypstem: | Mare j

Qff-chip Code memaory Qff-chip #<data memony
Start: Size: Start:

x]

Size:

Epram | | Ram | |

Eprom | | Fiam | |

E prom | | Fam | |

| Code Banking Start; End; [ 'far' mermary bpe support
Banks: Bank Area: | | [ Save address extension SFR in interrupts

0k, | Cancel Defaultz

Help

Figure 9. Options for Target dialog with Target tab

Zensys A/S Setting Up Keil uVision3
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In the “Output” tab activate the “Select Folder for Objects...” button and browse to the directory
“C:\DevKit_5 01\Product\LED_Dimmer\build\”

Browse for Folder @

Falder: ||.ﬂI bild ﬂ o~ 5 Ef-
Fath: CADevkit_5 00%ProducttLED_Dimmersbuild®,
0k,

Figure 10. Browse for Folder dialog

Zensys A/S Setting Up Keil uVision3 Page 11 of 35
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Change the ‘Name of Executable‘ to MyProject_US. Set the ‘Create HEX file’ check box.

Options for Tanget ‘MyProject’

Device | Target Output | Listing | User | C51 | 451 | LX51 Lacate | L1 Misc | Debug | Urilties |

| Select Folder for Objects... | Marne of Executable: |M}'F'f':'ie'3t_|-|5

* Create Executable: SbuildsMyProject IS

[v Debug Information [+ Browse Information [
W Create HEXFile  1yps Fomat |HEX-80 B3
" Create Library: . buildstyProject_US.LIB [ Create Batch File

0k, Cancel Defaults Help

Figure 11. Options for Target dialog with Output tab

Zensys A/S Setting Up Keil uVision3 Page 12 of 35
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3.3.1 Select folder for listings

In the “Listing” tab click on the “Select Folder for Listings...” button and browse to the folder
“C:\DevKit_5 01\Product\LED_Dimmer\build\”:

Browse for Folder @

Folder: | (3 build - Bt B
Path: C:ADevkit_5_00%ProductLED_Dirrnerbuild',
Ok,

Figure 12. Browse for Folder dialog

Zensys A/S Setting Up Keil uVision3 Page 13 of 35

CONFIDENTIAL



INS10246-5 Keil uVision3 IDE User Guide 2008-07-25

Set the listing option for the compiler, assembler and the linker as shown or use the default values:

Options for Tanget ‘MyProject’

Device | Target| Output Listing | User | 51 | 481 | LXB1 Lacate | L1 Misc | Debug | Urilties |

| Select Folder for Lishings. .. | Page Wwidth: {120 _|:| Page Length: |65 _|:|

Iv C Compiler Listing: . \builds®.|st
[v Conditional [v Spmbals v Hinclude Files v Azsembly Code

[ C Preprocessor Listing: . Sbuilds.i

v Aszembler Listing: Sbuildh” |t

[v Conditional [v Syrnbals Macroz: | Final expansion anly j [ Cross Beference

Iv Linker Listing: A\buildskyProject. map

v Memory Map [v Public Symbolz v Line Numbers [ Crosz Reference
[v Local Symbols [v Comment Becards [v Generated Symbols
I Linker Code Listing: . Mbuilds cod v Library Symbols

0k, Cancel Defaults Help

Figure 13. Options for Target dialog with Listing tab

3.3.2 Set compiler defines
In the “C51" tab set the following defines in the “Define” Edit box:
ZW_SLAVE, ZW020x, ZW0201, US, NEW_NODEINFO, APPL_PROD_TEST

Defines are found in the relevant makefiles in the application directory and the common makefile
directory.

The LED Dimmer application is located in the directory ‘C:\DevKit_5 01\Product\LED_Dimmer’ where
the relevant makefiles for the ZW0201 single chip are located. The needed defines for an US ZM1220
LED Dimmer are assigned to the CDEFINES parameter in the makefiles:

CDEFINES+=US,\
APPL_PROD_TEST

The common makefile is located in the directory ‘C:\DevKit_5_ 01\Product\Common’. The LED Dimmer
application uses a slave library and therefore the relevant makefile for the ZW0201 single chip is
‘Makefile.common_ZWO020x_slave’. Add the needed defines to the COMDEFINES parameter:

Zensys A/S Setting Up Keil uVision3 Page 14 of 35
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COMDEFINES:=2ZW_SLAVE,\
ZW020x,\
Z\W0201,\
NEW_NODE INFO
Be aware that some applications can have nested makefiles and it is therefore necessary to look through
all the relevant makefiles after the CDEFINES/COMDEFINES. Regarding a description of defines; please
refer to [4].
Set the “Include Paths” to:
.\.\Z-Wave\lO_Defines;..\..\Z-Wavel\include;..\Util_Func
For Developer’s Kit v3.2x and v3.3x set the “Include Paths” to

.\Slave;..\.\Z-Wavel\include;..\Util_Func

The paths correspond to the groups “Z-Wave Lib” “Z-Wave Inc” and “Utilities”. The paths for the “Z-Wave
Inc” and “Utilities” groups are always the same, independent of the targeted sample application.

Folder Setup

Setup Compiler Include Paths; X T+

AW avesl0_Defines
UMW avehinclude
UL Fune

| k. | Canicel

Figure 14. Folder Setup dialog

In the “Misc Controls” edit box enter the following compiler options:
DB OE NOCO SB LC CD

For an explanation for the C51 compiler options, please refer to [1].

Zensys A/S Setting Up Keil uVision3 Page 15 of 35
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Set the other options as shown below:

Options for Target ‘Release’ E|
Device] Target] Elutput] Listing] Uger C51 l.-'-‘-.51 ] <51 Lu:u:ate] <51 Misu:] Debug] thilities]

Preprocessar Symbols

Define: |E'W'_S LaWE, w0200, 20201, US, NEW_MWODEIMFO, APPL_PROD_TEST

Inidefine: |

Code Optimizatian

W arnings: |Warninglevel1 j
Lewvel: |11: Reuse Common Exit Code ﬂ ]
Bitz to round for float compare: m
Emphasts |Faw:ur size ﬂ I Global Register Coloring [v |ntermipt vectars at address; |0x0000

[v Linker Code Facking [max. AJMP ¢ ACALL) ™ Keep variables in arder

[ Don't use abzolute register accesses ) .
g [ Enable &M5I integer promotion rules

Include [ \Z5w/aveA_Defines; .\ \Z-Wavebincluds: AUt Func El
Paths
Misc DB OE NOCD SB LCCD

Contrals

Compiler  |LARGE OBJECTADWVAMCED WARNIMGLEYEL [1] OFTIMIZE [11,512E] BROWSE
contral  \NOIMTPROMOTE IMCDIR[. M 2w avesl0_Defines;. M 2w avehinciude;. Ut Func) DB OE

zhring
0k, | Cancel Default: Help
Figure 15. Options for Target dialog with C51 tab
Zensys A/S Setting Up Keil uVision3 Page 16 of 35
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3.3.3 Set assembler defines

In the ‘A51’ tab set the ‘Include Paths’ values to the same as used in the “C51” tab.
In the ‘Misc Controls’ edit box set the following options:

NORB DF(ZW_SLAVE,ZW020x,ZW0201,US,NEW_NODEINFO)

For an explanation of the A51 assembler options please refer to [2], but be aware that the DF directive is
an undocumented feature. Finally, for an explanation of the C defines please refer to [4]

Set the other options as shown below:

Options for Target ‘Release’ FE|
Device] Target] Dutput] Listing] User ] CHl AL IL><51 Lu:u:ate] 51 Misc] Del:uug] thilities]
Conditional &zzembly Control Symbals
Set: |
Reszet: |
bk acro processor Special Function Reagisters
L B-ieris W Diefine Bi61 SFH Names
[ MPL ’
Inciude T X : : ;
Faths |.."-.IEI_D efinesz; b W avehinchude;. UL Func J
ED%EE |NDHB DFEEW_SLAVE ZSW020x 20201 U5 HEW _MODEINFO)
Aszsembler  |INCDIR[ AO_Defines;. \ 2w avesinclude;. MIG_Func) HOREB
contral | DFZ2WwW_SLAVE Zw020w 2w 0201 U5 MEW_NODEIMFO) SET [SMaLL) DEBUG
ztring bl

0k | Cancel Defaultz Help

Figure 16. Options for Target dialog with A51 tab

Zensys A/S Setting Up Keil uVision3 Page 17 of 35
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3.3.4 Setlinker defines

In the ‘LX51 Misc’ tab, set linker options in the ‘Misc Controls’ edit box as follows:

DW (13,16,25) NOOL CLASSES(IDATA(D:0-D:0xff),XDATA(X:0-X:0x7ff),CODE(C:0-C: 0x 7fff))
SEGMENTS(?CO?ZW_RF020X_FTBL (C:0X7F80))

Now Target option configured correctly. For an explanation of the linker options please refer to [2].

Options for Tanget ‘MyProject’

Device] Target] Dutput] Listing] User ] CH1 ] A5 ] 51 Locate =51 Misc l Del:uug] thilities]

W arnings

Level 2 - dizable " arming Mumbers: |

[ use linker control file:

[ Create relocatable output file [LIMEORLY) [ Casze sensitive spmbols

Azzign

Owverlay

Mize D% [13.16,25] HOOL CLASSESIDATA[D:0-D: 0xf) SDATAR: 0 0= 78] CODE [C: 0-C: 0= 7F)
contrals  |SEGMENTE[?COY2w_RF020-_FTEL [C:0<7F20])

Linker 170" AbwildstyProject'
contral  |REGFILE [.sEuildsMyPraoject ORC]

ghring
0k | Cancel Defaultz Help
Figure 17. Options for Target dialog with LX51 Misc tab
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3.3.5 Set utilities

Configuring Flash Tools.

In the 'Utilities' tab set the flasher options as follows:

Select “Use External Tool for Flash Programming”

In “Command” field type the full path to the Z-Wave Programmer:
C:\Program Files\Zensys\ZWaveProgrammer\ZWaveProgrammer.exe
in the “Arguments” field type the Z-Wave Programmer command line:
-c COM19 -pf US -p "#H"

where COM19 indicates the COM port to what Programmer is connected and US select the frequency for
a given country code.

For country codes and other command line options (home id, EEPROM programming) see the Zensys,
INS10679, Instruction, Z-Wave Programmer User Guide.

Select “Run Independent” check box.

Options for Target ‘MyProject’

Device] Target] Elutput] Listing] |zer ] CH1 ] AR1 ] 51 Locate | LxB1 Misc | Debug  Utilities
Configure Flagh Menu Command

" |Jze Target Driver for Flash Frogramming

| = -
It File: o

{* |Jse External Tool for Flash Programming

Command: |I::"~F'r|:|gram Files'Zensys W aveProgrammersi aveProgrammer, exe

Arquments: |-n:: COM19 -pf IS -p "HH"

[+ Run Independent

0k, | Cancel Defaults Help

Figure 18. Options for Target dialog with Utilities tab

Refer to “Uploading firmware to the Z-Wave Module” regarding how to upload the firmware.
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3.4 Building target

To build the target, select ‘Build target’ from the ‘Project’ menu. The hex file must be successfully
generated which can be verified in the Output Window.

EMypmject - p¥ision3 E|@E|
File Edit Yiew Project Debug Flash Peripherals Tools SWCS Window Help

BaHg BB D
| Project Warkspace
=121 MyProject
#-[77 Appl Source Code
EIEI Z-Wave Lib
EI[E Z-wave Inc
- [77 Utilities

¢ o 7 % Gy Ca# |« = & @ |B]E]| O e o £

Br. = @ [*pr [ @Te |

X¥1Build target 'MyProject' ﬂ

T compiling LEDdim.c...

assembling Lpp RFSetup.aSl...

compiling one_button.c...

compiling slave learn.e...

linking...

Program 3Jize: data=199.5 xdata=9558 const=113 code=13145
Global register optimization - pass #1

comwpiling LEDdim.c...

linking...

i Program Size: data=199.5 xdata=958 const=113 code=13145

Bllereating hex file from ".%buildiMyProject™. ..

% " Ybuild MyProject” — 0 Erroris), 0O Warning(s).

= b
=

Sl e puild 4 command 4 Findin Files [ [+ I'IJ
Ready [ simulation [ ’_

Figure 19. Output that KEIL uVision3 generated during build

3.5 Uploading firmware to the Z-Wave Module

After successfully build, upload firmware to the Z-Wave Module using Z-Wave Programmer.

Regarding how to configure the flash tool refer to

Zensys A/S Setting Up Keil uVision3 Page 20 of 35

CONFIDENTIAL



INS10246-5 Keil uVision3 IDE User Guide 2008-07-25

3.5.1 Set utilities

Configuring Flash Tools.

To download the firmware, select the “Download” from the “Flash” menu:

EMmejecl - pVision3
- Fle Edit Wiew Project Debug Flgshl Peripherals Tools SYWCS ‘window Help

= - Download
| Project Workspace
=¥ MyProject
E@ Appl Source Code
eeprom.h
-] LEDdim.b
LEDdim.c
[ Bpp_RFSetup.ast
V[0 2-WaveLib
B[ Z-Wave Inc
[ Utilities

I Y SR - W= A B =] o] R

#

m ) =
§5 Eras

Configure Flash Toals. ..

“BF [= [@e [ [®Te |

*|assembling Lpp RFSetup.aSl... d
" compiling one hutton.c...

compiling slave learn.c...

linking. ..

Program Size: datsa=199.5 xdata=953 const=113 code=15145 J
Global register optimization - pass #1

cowpiling LEDdim.c...

linking. ..

-é Program Size: dats=199.5 xdata=958 const=113 code=185145

Z|[creating hex file from ".%buildiMyProject™...

Z|".4build\MyProject” — 0 Error(s), O Warningis). -
ST E T ] Build f Command }, Findin Files f | 1 I 3
Download ta Flash Memory | |Simulation [ =

Figure 20. Flash menu

Now the firmware should start downloading to the ASIC.

Zensys A/S Setting Up Keil uVision3 Page 21 of 36

CONFIDENTIAL



INS10246-5 Keil uVision3 IDE User Guide 2008-07-25

:\Program Files\ensys\/WaveProgrammer\WaveP rogrammer. -0 ﬂ
B

Z—Wave Programmer Uersion 1.04
Freguency US selected
Detected:ZWOD201

Erazing flash

FLASH programming start.
Programming Flash progress: 33

Figure 21. Z-Wave Programmer output
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3.6 Creating and using multi project workspace

3.6.1 Creating new multi project workspace

In case when project must be able to generate firmware for different countries, then create multiple
uVision projects for each country. After this, add all such projects to single uVision workspace.

To create workspace select “New...” -> “Project Workspace” from “Project” menu of the uVision3.

Eu\'ision:i
.Eile Edit  Wiew Erojectigebug Flash Petipherals Tools S¥CS window Help
_1% Dﬂ‘m d| Mlet. .. pivision Project. .. i _I,fg SN ‘1§| = .g“.. Ay @Fﬁ £ !
Impart pvisionl Praject... Project Workspace. ., .
[Project Warkspace R

Cpen Projeck...

Manage 4

EIF..| E. |([@e. |*BFu. | BTe. |
: -
3
2
=
2 -
ST e T2 Buitd f Command Find in Files ”_I—I‘ L
Create a new multi-prajeck workspace | [ | ,_ 7ﬂ

Figure 22. Workspace creation

Select the workspace directory and name. In this example the workspace directory is
C:\DevKit_5 01\Product\LED Dimmer and the workspace name is MyProject.
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Create New Multi Project Workspace

D

My Recent
Dacuments

ol

Desktop

i
by Documents
ty Computer
ke M etk
Flaces

Save jn: | =9 LED_Dimmer

~| & @k EE-

File name:

Save as type:

|M uProject

[

|Multi Froject workzpace Files [*.mpw]

El

| Save |
Cancel

Figure 23. Dialog to select the folder for new workspace

Now add the all uVision project files to the work space:

Zensys A/S
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Create Mew Multi-Project Workspace [E|

p¥ision Project Components l

pvision Projects: b A AL <

CADevkit_5_00ProduckiLED_DimmeriMyProject LIS, LivZ
CADevkit_5_00yProduckLEC_DimmeriMyProject _ELLLvZ
CADevkit_5_00yProduct\LED_DimmeriMyProject _HE, Livz

C:iDevKit =) DDiPdeuctiLED DimmeriMiF‘rniect AMNZ, vE

Ik | Cancel | Help

Figure 24. Create New Multi Project Workspace dialog with the required projects added

3.6.2 Using multi project workspace

- To set active project in the workspace, select the needed project in the Project Workspace window,
click right mouse button on it, and select “Set as Active Project”.

Kk MyProject_US - p¥ision3

File Edit Mjew Project Debug Flash Peripherals Tools SWiCS5  Wind

B« d

Project \Warkspace x

—|-== WorkSpace
Rl 1 Project_S

[[3 M™yProject_EU

3 W

3 Mw:,-'F'| Set as Active Project ||

+- ][

Figure 25. Shortcut menu to set the Active Project
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- To build only current active project, see Building target.

- To build multiple projects at once, select “Batch Build...” from “Project” menu, and select Project targets,
which need to build, or press “Select All” to select all Targets.

Batch Build

Seleck Project Targets:

MuwProject_anZ
v MyProject
MwProject_EL
v MyProject
MuwProject Hk
v MyProject
MuwProject_LIS
v MyProject

Build

Rebwild

Clean

Select Al

Deselect Al

Help

Close

Figure 26. Batch Build dialog

Now press button with desired action: Build, Rebuild or Clean.

- To have possibility in opening workspace files in uVision from Windows Explorer see Associate uVision
multi project workspace file in Chapter 8.
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4 THE SIMULATOR

The Keil uVision3 IDE has an integrated simulator. To use the simulator to debug Z-Wave application an
add-in simulator DLL module must be installed to simulate the ZW0102 or ZW0201 specific hardware
and the external EEPROM if present. There are no plans regarding development of these add-in DLLs,
but the description below explains how to add them to the IDE.

Assume that the add-in DLL called ‘zw0102.dll’ or ‘zw0201.dII’

Copy the file to ‘c:\keil\c51\bin’, if this is the path to the IDE.

From the ‘Project’ menu select ‘Options for target LEDdim_US’.

Select the Debug fane.

Write the following in the ‘CPU DLL’ edit box: S8051.DLL.

Write the following in the ‘Dialog DLL’ edit box: DP51.DLL

Write the following in the ‘Parameter’ edit box: -p320 —dzw0102 or: -p320 —dzw0201.

NooRrwN =

Options for Target ‘LEDdim_LS*

Device | Target | Output | Listing| C51 | 451 | BLS1 Locate | BLS1 Miss  Debua | Utiites |
f* |Jze Simulator Setiings || ¢ Use: |KeiIMDnitDr-51 Diriver ﬂ Settings |
v Load &pplication at Startup v Go till mainf) v Load Application at Startup [ Go till mainf)
Initialization File: | nitialization File:
Reztore Debug Session Settings Feztore Debug Session Settings

[+ Breakpoints [+ Toolbox [+ Breakpoints [+ Toolbox

v wfatchpoints & P [ watchpoints

[v Mermomny Display [v Memomy Display
CPL DLL: Fararneter: Drriver DLL: Fararneter:
|SSIZIE1.DLL | | |
Dialog DLL: FParameter: Dialog DLL: FParameter:
DPS1.0LL |-p320 -dzwil1 02 | |

] | Cancel | Defaultz |

Figure 27. Options for Target dialog with Debug tab
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5 CREATING A NEW DEVICE IN THE DEVICE DATABASE

To add new devices follow the steps below:

1  Select a CPU that is similar to the new device. Be sure to double-click to bring the settings for this
device into focus.

Change the name of the chip vendor.

Select the appropriate CPU family.

Enter the part number in the device text box.

Modify the description to match the new device.

Change the options for the tools (see below).

Single-click in the database window (to change focus). This enables the Add button.

Click Add to add the new device.

ONO AR WN

5.1 Adjusting the Options...

In the Options box, CPU= specifies the basic tool settings for the chip. The parameters for CPU= are:

= IRAM (range)
Address location of the on-chip IRAM.
= XRAM (range)
Address location of the on-chip XRAM.
= XRAM2 (range)
Address location of a 2nd on-chip XRAM area (i.e. for C167CS).
= IROM (range)
Address location of the on-chip (flash) ROM. The start address must be 0; the part is
automatically split into two sections, if the size is more than 32KB. The range
specifies the physical ROM size.
= ICAN (range)
Address location of the on-chip CAN module. Use for C167 and variants only.
= CPUTYPE (variant)
Specify CPU variant for ARM based controllers. Currently only ARM7TDMI is
supported.
= EBIG
Default to BIG endian for ARM based controllers.
= CLOCK (val)
Default CPU clock speed (in Hz) used when selecting the device. For example
CLOCK(12000000), indicates a 12MHz oscillator.
= MOD167
Use the extended instruction set of the C167 and variants.
= MOD517DP
Allow to enable Infineon specific multiple DPTR registers.
= MOD517AU
Allow to enable the Infineon specific Arithmetic Unit.
= MODA2
Allow to enable Atmel specific multiple DPTR registers (like on AT89S8252).
= MODAB2
Allow to enable Analog Devices specific multiple DPTR registers.
= MOD_CONT
Enable support for the Dallas Contiguous Mode.
= MODDA
Allow to enable Dallas specific Arithmetic Accelerator.
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= MODDP2
Allow to enable Dallas specific multiple DPTR registers.
= MODP2

Allow to enable Philips specific multiple DPTR registers. (Note also some Atmel
devices are using this variant).

= MODE2

Use the Infineon SLE66 instruction set extensions.
= P51

Use the Infineon SLE66 specific LP51 linker instead of LX51.
= MODV2

Use the Infineon XC16x / ST SuperlO instruction set extensions.
= MX
Enable support for the Philips 80C51MX architecture.

= MXP
Enable support for the Philips SmartMX SmartCard architecture.
= DPX

Enable 24-bit DPTR register for the Analog Devices ADuC812.
In addition there are two other options that specify files. These are:

= REGFILE (sfr_file)
Specify the SFR register definition file for the CPU.
= SFILE (startup_file)
Specify the default startup file that should be copied to a project.

Other options specify data books and uVision3 debugging DLLs. Leave these variables unchanged when
adding a new device to the database.
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6 MODIFYING THE ZW0102 DEVICE IN THE DEVICE DATABASE

The ZW0102 model in the device database is incorrect with respect to Flash and IRAM size. The correct
values are 32 KB of Flash ROM and 128 KB IRAM.

The ZW0102 model is corrected as follows:
1. From the “File” menu choose “Device Database®.
2. In the Device Database dialog scroll down to the Zensys devices, double click on Zensys.

Device Databaze 3]

Databaze l

D ata baze Vendor |

+ @ ST Microslectronics A
+ @ SynchOs ~ Eamiy |MCS-51 |

&dd
+ & Synopsys Device: |
+ @ Syntek Semiconducte -
+ @ TDK Dezcription;
+ @ Temic
+ i Tl
+ & Triscend
+ @ winbond

& ! 2 Optionz:

Figure 28. Device selection in the Device Database dialog
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3. Now double click on ZW0102 and the “Description” and “Options” textboxes shows the ZW0102
properties.

Device Databaze 3]

Databaze l

D ata baze Vendor: |2&ns_l,ls
+ @ 5T Microelectionics A

o SyncMs Eamily: |MCS-51 =]

+- @ Syropays Device: [Zw/102 Update
+ @ Syntek Sermiconducts =
+ @ TDK_ Drezcription;
* @ Teric 2057-based microcontroller with 24 ave RF tranceiver,
+ @ Tl_ 10-bit ADC, SPI interface, UART, 20 KBytes Flazh ROM,
+ @ Trizcend 2048 Bytes Rakd
+ @ Winhond
- @ ZEnEys

1 Bl

L

Optionz:

BOOKO=DATASHTS4ADDBOOES . PDF["Add on databooks")
CPU=IRAMI0-0=FF] =RAM[0-0:7FF] IROM(0-0x4FFF) CLOCK[7376374)
SFILE="LIBNSTARTUP.AB1" ["Standard 8051 Startup Code")
BOOK=DATASHTSAMTELMSMET. PO nstuction Set Manual)
REGFILE=2w/0102 H[ "zehays")

Figure 29. Selecting ZW0102 options in the Device Database dialog
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4. Inthe “Options” textbox, change IRAM(0-0xFF) to IRAM(0-0x7F), and IROM(0-0x4FFF) to IROM(O-
0x7FFF). Remember also to update the “Description” textbox.

Device Database

Database ]
Data;se Yendor: |2l3f13_'r'S
+ 55T L
+ §® 5T Microelectionics Family: {MCS-51 |
+ -G TDK | | Update_|
+ @: Temic Dezcription;
* @ Tl_ 3051 bazed Micracontraller with 24 ave BF Transceiver
+ & Triscend 10 bit ADC, 5P interface, UAR,
+ % YWinbond 32 KB Flash ROM, 2 KB RAM
[ 2wiozm 2
b
£ | % O ptiars:
BOOKO=DATASHTS'ADDEBOOKS . PDF["Add on databoaks"]
CPU=IRAM[0-0:FF) =RaAM[0-0:7FF) IROM[0-024FFF) CLOCK[737E574)
SFILE="LIB:STARTUP.AST" ["Standard 8051 Startup Cade'')
BOOK1=DATASHTSAHTELWSMET . PDF["Instruction Set b anual']
REGFILE=2w 01 02 HI zensys']

Figure 30. Correcting ZW0102 memory map in the Device Database dialog

5. Finally activate the “Update” button to save the changes.
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7 CREATING A MODEL FOR THE ZW0201/2wW0301 DEVICE

It is necessary to create a model in case the Keil uVision IDE do not support the ZW0201/2ZW0301 single

chip as follows:

1. From the “File“ menu choose “Device Database®.

2. The ZW0201/ZW0301 chip uses the Mentor Graphics 8051EW core. Select the Mentor Graphics

devices from the “Data base” and double click on 8051EW device.

Device Database E| E|

Databaze ]
Data base Yendor: |Ment-:|r Graphics Co.
+ @ Infineon ~
+ @ InnovaSIc Farnily: |MES'51 ﬂ
+ G Intel D evice: |MBEIE1 Ew Update
+ % 1551
+ @: b acim _ Dezcription;
T @ Mentor Giraphics Lo. 3051 bazed CMOS Microcontraller with High-5 peedeoare,
3 M51 32140 linez, 2 Timerz/Counters, 14 Interrupte/d priority levels,
CaEEEE up to 8 DPTRs, JTAG interface,
(L3 ME0ETW G4 KB ROM, 256 Bytes on-chip RAM. 64 KB Ext. Rak
3 Mensz
+ % Micronas
+ - MXIC L/
£ % O ptiars:
SIM=582051.0LL DPS1.DLL"p51") A
SFILE="LIBNSTARTUP AR ["Standard 8057 Startup Code')
BOOKO=DATASHT S \ADDBOOKS PDF["Add on databookz")
BOOKI=DATASHTSMMTELMSMET. PDF["nstuction Set Manual’]
CPU=IRAMID - 0=FF] =RaM[0-0-FFFF] IROM[0-0=FFFF) CLOCK[12000000] MODP2
MOMN=53051.0LL TPE1.DLL["p5A1")
REGFILE=REGH1.H 3
Figure 31. Selecting database in the Device Database dialog
Zensys A/S Creating a Model for the ZW0201/ZW0301 Device Page 33 of 36

CONFIDENTIAL



INS10246-5 Keil uVision3 IDE User Guide 2008-07-25

3. Select the Zensys devices from the “Data base”. Update “Vendor” to Zensys and “Device” to
ZW0201/ZW0301. Enter a description of the ZW0201/ZW0301 single chip in the “Description”
textbox. Modify the “Options” textbox as follow: CPU=IRAM(0 - OxFF) XRAM(0-0x07FF) IROM(O-
0x7FFF) CLOCK(16000000). Finally activate the “Add” button to create the model in the Zensys
device database.

Device Database

Databaze ]
Data;se Yendor: |2'E*ﬂ$_'r'S
+ S5T L
+ @ ST Microelectronics Farily: ||""'“:5'5-I ﬂ e
+ @ Synopsys Device: 20201
< TDK
+ @ Temic Dezcription;
+ @ Tl_ 2051 baszed Microcontroller with £ ave BF Trangceiver
+ @ Triscend 12-Bit ADC, SP! Interface, UART,
+ @ Winband 32 KB Flash ROM, 2 KB RAk
- Zensys
[ 2wz
[ 2wiozm
w
£ 2 O ptiors:
SIk=58051.0LL DPS1.DLL"-p51") A
SFILE="LIBMSTARTUP AR ["Standard 8051 Startup Cade')
BOOKO=DATASHTSYADDRBOOKS PDF["Add on databoaksz")
BOOK1=DATASHTSMMTELYMSMET. POF[ Instruction Set Manual'’)
CPU=IRAMID - 0=FF) #Rak[0-0-07FF) IROM[0-027FFF) CLOCK 16000000 MODP2
MOM=58051.0LL TPS1.DLL["-p51")
REGFILE=REGHR1.H 3
Ok

Figure 32. Entering option data in the Device Database dialog
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8 TROUBLESHOOTING

- Make sure to add all needed libraries and RF .obj files to the project (see section 3.2).

- Make sure all needed defines and control words is added in the target options tab such as country type,
chip name, etc. (see section 3.3).

- Associate uVision multi project workspace file (.mpw) with Keil uVision3 IDE.
If you double-click a .mpw file in Windows and it opens in the wrong program, follow these steps to
associate this file extension with Keil uVision3 IDE.

¢ Open the folder that contains the file you want to change.

¢ Click on .mpw file or right-click the file, and then click Open.

Choose “Select the program from a list” and then click “Ok”.

In Programs list select uVision3 IDE.

Select the “Always use the selected program to open this kind of file” check box, and then click
OK
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